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Application of GIS for hazard and 
risk assessment: Tegucigalpa, 
Honduras 

Part 3: Elements at risk mapping 
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Ruben Vargas Franco: (E-mail:  vargas@itc.nl ) 
 
International Institute for Geo-Information Science and Earth Observation, ITC  
P.O. Box 6, 7500 AA Enschede, The Netherlands 
 
 

This exercise deals with the preparation of the spatial data necessary for developing 
a building and infrastructure risk assessment.  The work will be split amongst the 
participants and the various pieces will be glued together to produce one map.  Due 
to the time available, this exercise will be done for a portion of the city. The flow-
chart on Figure 1 illustrates the procedures which are necessary for generating the 
spatial database necessary for mapping the elements at risk.   

 
Disclaimer 
The material in this exercise is for training purposes only.  The results should not be 
used in actual planning of the city of Tegucigalpa as ITC does not guarantee the 
accuracy and precision of the input data. 
The GIS software that will be used in this exercise is the Integrated Land and Water 
Information System (ILWIS), version 3.11, developed by the International Institute 
for Geo-Information Science and Earth Observation (ITC). Information: www.itc.nl 
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3.1 On-screen digitizing building information on a Stereo 
image 

 

 
Figure 2.1:  Flow Chart of Operations for Developing a Spatial Database for Mapping Elements at 

Risk   
 

Time requirement: 2 hours 
 

Objectives: 
• On-screen digitize the homogeneous units (homogeneous in terms of 

building size and pattern) that can be identified on the satellite image. 
• Generate a segment map and a point map, which will be combined into a 

polygon map. 
• Generate a table with the information that will later on be collected in the 

field. 
 

Data needed: 
• Ortho image:  Ortho_tegu (year 200?), (raster image) 
• Stereo image in colour, for use with screenscope: Ortho_stereo  

• Stereo image in black and white, to be used as anaglyph: Ortho_stereo_bw 
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• Road map: Roads_tegu (segment) 
• Map of the colonias: Colonia_tegu (polygon map with table) 

• Flood extend map of the Mitch event: Flood_Mitch (polygon map) 
 

3.1.1 Extracting boundary lines of building blocks from the road map. 
The following section explains first how to make a segment map for buildings using 
existing information from the road network. (Note: this part can be skipped in case 
of time problems. In that case use the file buildings_blocks (in the directory 
/results) and proceed with the next exercise . 

 
 

��    
• Open the domain Roads_tegu and add an extra class called Include.    

• Copy the segment map Roads_tegu (with Edit / Copy Object to) to 
another file with different name: Roads_temp 

• Open the map Ortho_tegu and add the layers: the polygon map 
Flood_mitch and segment map Roads_temp  

• You will see the roads that are in the area covered by the Mitch 
flooding. Those are the ones that will be renamed to the name 
Include, so that we can copy them to another file and use them  for 
the building mapping. 

• Select Edit / Edit layer and select the segment map Roads_temp.  

• Select all the roads in the area covered by the polygon map 
flood_mitch and rename them to Include. You can select multiple 
segments using the CTRL button. 

• Close the segment editor and the map window.  
• Copy the segments with the name Include from the file Roads_temp 

into another file Buildings_tegu. You can do this by selecting 
Operations / vector operations /Segments /Mask segments. Use mask 
Include. The new file only contains the roads in the flood-affected 
areas and can be used as the basis for digitizing the elements at risk. 

• Before you can edit the file Building_tegu, make sure to break the 
dependency 

• Create a table Roads_tegu using the domain Roads_tegu, and add a 
column Building_blocks, which should have a class domain 
Building_blocks, and only one class (building_blocks) 

• In the properties of the map Building_tegu, add the table Roads_tegu 
• Create an attribute map of the segment map Building_tegu, using the 

column Building_blocks from the table Roads_tegu. Name the 
output segement map: Building_blocks.  This map now has its own 
domain, and is no longer linked to the domain Roads_tegu. Break the 
dependency of the segment map Building_blocks. 
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3.1.2 Digitizing homogeneous units 
Now we start with the actual screen digitizing the segment of the homogeneous units 
in the map Building_blocks. It is possible to do that in three ways: 

• On top of the orthoimage Ortho_tegu. In this case you will not be able to 
see stereo, which is a disadvatage in the interpretation. 

• On top of the colour stereo image Ortho_stereo. This is the best way, but 
you will need a screen stereoscope for that. 

• On top of the anaglyph stereo image Ortho_tegu_bw. You will need 
anaglyph glasses for the interpretation. The problem is that the lines will 
not exactly match with the features in the image. In ILWIS 3.12 this can be 
adjusted using the Pixel shift option.  

 
In this exercise we will show two options: 
1 . Segment map Building_blocks displayed on top of the orthoimage, while you 
compare the result with the anaglyph image. 
2.  Segment map Building_blocks displayed on top of the stereo colour image, using 
the screenscope. 

 

3.1.2.1 Screen digitizing on ortho image 
 

��    

• Open the raster image Ortho_tegu.  Check its properties (by selecting 
its Properties in the File menu) to make sure that the map is linked to 
the georeference Tegucigalpa. 

• On the Layer Menu, go to Add Layer and select the 
Building_blocks segment map (if you didn’t make it in the previous 
exercise, copy the file form the directory results).  Repeat the same 
procedure to add the Flood_Mitch polygon map, tick Boundaries 
Only, select the Boundary Color red and a Boundary Width of 2). 

• Now you can view the segments of the different Building blocks 
within the flood affected area. Select a few building blocks to digitize. 
Discuss with your teaching staff that one should be digitized.   

• Open the map Ortho_tegu_bw as anaglyph map in another window. 
Zoom in on the same area as you want to digitize in the ortho_tegu 
map. Use anaglyph glasses to get stereo. 

• In the map window of Ortho_tegu select Edit / Edit layer and select 
the segment map Building_blocks 

• Next you must on-screen-digitize the boundary of the homogeneous 
units inside it.  Given the resolution of the imagery available, one can 
distinguish between different building types within the same building 
block. You may also decide to map individual buildings. Also digitize 
vacant land. Use the pen in the editor menu to digitize. Compare with 
the three dimensional image in the anaglyph. 

 
• Make sure to connect all lines together. 
• When you finish digitizing one segment, select the segment with the 

Select Mode icon (the hand) and choose the correct class.  Next select 
the Insert Mode icon (the pencil) and digitize the following segment. 

• When you are finished with the digitizing procedure, go to the File 
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Menu, first select Exit Editor and next select Create Point Map.  
Name the output map Building_block_tegu and create a domain type 
Identifier with name Building_block_tegu.  After the domain window 
opens, close it and also close the Create Point Map window. 

• Digitize one point inside each of the homogeneous units with the 
Insert Mode tool (the pencil).   If you did not enter any classes in the 
domain yet, choose new and enter a name for this area. Give each of 
these points a unique identifier, starting with the Tegucigalpa colonia 
number and a sequential number to identify each homogeneous unit 
(e.g 001-001 or 085-012).  When you finish digitizing the necessary 
points, go to File and select Exit Editor. 

• Next you will open the editor of the segment map and you will check 
the segments.  Go to the File menu and select Check Segments. Select 
Self Overlap.  Repair all the mistakes. Ask a teacher to assit you the 
first time. 

• Then check segments using Dead Ends, and Intersections. Repair all 
mistakes. 

• Next you will use the editor of the segment map and you will attempt 
to polygonize it.  Next go to the File menu and select the Polygonize 
operation.  Select the point map Building_blocks_tegu, the domain 
Building_blocks_tegu and name the resulting polygon map 
Building_blocks_tegu.  If the software detects any error, it will 
highlight the type of error and its location.  If there are errors in your 
layer, you can use the Select Mode, Move Points, Insert Mode and 
Split/Merge Mode tools (see icons below) to correct the error(s).  
When you finish, go to the File Menu and select Exit Editor. 

 

3.1.2.2 Screen digitizing using the screen stereoscope 
 

��    
• Open the three dimensional image Ortho_stereo 

• Make sure the right image button is selected. On the Layer Menu, go 
to Add Layer and select the Building_blocks segment map (if you 
didn’t make it in the previous exercise, copy the file form the 
directory results).  Repeat the same procedure to add the Flood_Mitch 
polygon map, tick Boundaries Only, select the Boundary Color red 
and a Boundary Width of 2). 

• Place the screen stereoscope before the screen. Maximize the window, 
zoom in on the area surrounding the stadium and click the unlock 
button (red traffic sign). Adjust one of the two windows until you see 
good stereo. Click on the lock button.  

• Now you can view the segments of the different Building blocks 
within the flood affected area. Select a few building blocks to digitize. 
Discuss with your teaching staff that one should be digitized.   

• Select Edit / Edit layer and select the segment map Building_blocks 

• Next proceed in the same way as described in 3.1.2.1 starting from the 
bullet with the picture. 

• When you finish, go to the File Menu and select Exit Editor. 
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3.2 Table(s) and Attribute Column Generation (pre-fieldwork) 

 
You have concluded the phase of mapping the elements at risk.  The next phase 
consists of building the table (s) necessary for storing the attributes of the elements 
at risk. 
 
Time requirement: 1 hour 
Data needed: 

• Building block map that you generated in the previous section: polygon 
map Building_blocks_tegu  (if you don’t have it copy it from the directory 
results) 

• Road map: Roads_tegu (segment) 
• Map of the colonias: Colonia_tegu (polygon map with table) 

 

��    

• On the main window, select the polygon map Building_blocks_tegu, 
click on the mouse’s right button and select Properties.  Tick on 
Attribute Table and select the create table icon.  Select the domain of 
the Building_blocks_tegu and name the resulting table 
Building_blocks_tegu.    

• After the table opens, you can add a column with the code of the 
Colonia. Create a column Colonia, and use the domain Colonia_tegu. 

• Enter for each record the number of the Colonia (the first number 
without the zero) 

• Join the table with the table Colonia_tegu. Use Columns / Join. Select 
the column Barrio. Accept the defaults of the join wizard and name 
the output column Colonia_tegu. 

• You can now proceed by adding the columns related to the attribute 
information (see the table below for the names of columns and 
domains).  Therefore, on the table’s Columns menu, select Add 
column.   

• Note that in case several persons are doing the field collection and the 
tables from the individual surveyors will have to be glued together, 
one must make sure that all surveyors use the same names for the 
columns and for the domain classes. 

• This information can then be used in the field for collecting 
information on the different types of buildings. 

 
The polygon map and its table can be used on a handheld computer in the field for 
collecting the attribute information about the characteristics of the homogeneous 
units.  Esri’s ArcPad is an example of a software package that allows to do GIS on 
handheld computers.   
Keep in mind that if the field collection of attributes will also be split into teams, if 
during fieldwork you decide to further subdivide an area or edit a boundary, you 
would have to make the edits on the individual segment map and the individual label 
point map rather than on the glued ones. This would imply that after fieldwork you 
would have to glue the individual segments and point maps as well as the tables plus 
polygonize and rasterize again. 
Note that if you were going to use this dataset to make inferences about the density 
of population, you would need to record detailed landuse classes (e.g. primary 
school) as well as the general classes (e.g. other educational).   The detailed classes 
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are also important for emergency planning purposes.  The general classification 
could be stored in a separate table and joined into this main table only if required. 
Note that this section is only a demonstration. We will not use the dataset that you 
made in the next exercises on vulnerability assessment. 

 
Variable Type Min Max Precision 
Colonia Existing class-domain Colonia_tegu of polygon 

map Colonia_tegu 
- - - 

Landuse Class-domain “Landuse” with the following 
classes: 

• Residential 
• Commercial 
• Industrial 
• Educational 
• Other institutional 
• Recreational 
• Agricultural  
• Vacant 

- - - 

BuildingType Class-domain “Type” with the following classes: 

• Wood 
• Stone 
• Unreinforced masonry 
• Reinforced concrete frame 
• Concrete shear walls 

- - - 

Age Class-domain “Age” with the following classes: 

• 0-5 years 
• 6-10 years 
• 10-25 years 
• > 25 years 

- - - 

NrOfFloors Value 0 50 1 
IncomeGroup Class-domain “IncomeGroup” with classes:  

• High 
• Moderate 
• Low 

- - - 
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3.3 Field data collection 
In this exercise you will go in the field to collect the data for the elements at risk 
(buildings) that you have outlined in the previous exercises. The study will be made 
by evaluating buildings in the area affected by the flood during Mitch. You will be 
using a location map in which the homogeneous units are indicated.  An example of 
such a map is shown below. 
 

 
You will also work with a checklist in the field, that contains similar information as 
the columns you have entered in the database earlier. The checklist is shown on the 
next page. The survey is done by sampling typical buildings within each building 
block. If within one building block there are several types of building, sample more. 

 

��    

• Work in groups of 2 persons. Each group will have its own number 
and will visit another area.    

• Describe individual buildings. 
• Plot for each building a point on the overlay over the location map.  

• Enter in the table (column Building_block_tegu) the number of the 
homogeneous unit that is indicated on the map (e.g. 159-003) 

• Give each building a separate nr (Building_nr) per block. 
• Indicate the percentage of the buildig block with similar buildings 

• Use the codes for entering the classes of Landuse, BuildingType, Age 
and IncomeGroup. The number of floors can be entered as a single 
value. 
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Names: 
Group number: 
Date: 
 

Building_block_
tegu 

Building 
Nr. 

Perc, 
similar 

Colonia Landuse BuildingType Age NrOfFloo
rs 

IncomeGroup 

         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         
         

 
Legend 
 
Landuse BuildingType Age IncomeGroup 
R Residential W Wood 0 0-5 years H High 
C Commercial S Stone 6 6-10 years M Moderate  
I Industrial UM Unreinforced masonry 10 11-25 years L Low 
E Educational RC Reinforced concrete 25 >25 years   
OI Other 

Institutional 
CS Concrete shear walls     

Re Recreational       
A Agricultural       
V Vacant       
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3.4 Entering result in the database 
After returning from the fielddata collection, the next step is to enter the data in the 
GIS database.  As you have made samples of buildings within the homogeneous 
units (building blocks), you will make a point file with the samples, and enter the 
data in a table linked to this point map. Later you can join all information from all 
groups together into a single table (Building_blocks_tegu). 

 

��    
• Open the raster map Ortho_tegu and overlay the polgonmap 

Building_blocks_tegu (only show boundaries).    

• Create a point map Building_sample_XX (in stead of XX use a 
number of your group) use a domain Building_sample_XX (Identifier 
domain). 

• Digitize the sampling points that you surveyed. Give each point the 
name of the homogeneous unit plus the building number. For example 
in homogeneous unit 159-003 if you have made 5 samples, they will 
get the names 159-003-01 , 159-003-02 etc.  

• Create the following columns with the following domains: 
��Building_block_tegu  domain: building_block_tegu 
��PercentageSimilar domain percentage 
��Colonia domain Colonia_tegu 
��Landuse domain Landuse 
��BuildingType domain BuildingType 
��Age domain Age 
��NrOfFloors domain NrOfFloors 
��IncomeGroup domain IncomeGroup 

• Enter the values of your checklist in the table 
  

 
When you have finished digitizing the points and entering the data in the table, give 
the point map and the table to the teacher. He will combine the files in a single table 
and point map. 
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3.5 Estimating building heights using DEM’s 
Time required: 2 hours 

 
The objective of this exercise is to use two DEM for the estimation of the building 
heights. The following DEMs are available: 

• A DEM made from LIDAR survey, which contains very detailed 
information on all objects on the surface, including buildings, trees, and 
even cars during the time of data acquisition.  The file is available as 
Lidar_dem. 

• A DEM derived from detailed contourlines, digitized from topographic 
maps. For Tegucigalpa contour lines are available with a contour interval of 
2.5 meters. They are stored in a segment map called Contour_map. 

For the calculation you will also need the building map that was generated in the 
previous sections (Building_block_tegu) 

 

��    
• Open the raster map Lidar_dem and overlay the segment map 

Contour_map (use single colour and keep info on)  

• Use PixeInfo to compare the values of both maps.  
• Select Operations / Interpolation / Contour Interpolation. Select 

segment map Contour_map, and georeference Tegucigalpa. Select 
output map: Topo_dem. Use value range from 500 to 2000 and 
precision of  0.01. The interpolation will take some time.    

• When the calculation is finished and the map is displayed, ad the 
segment map Raods_tegu and check again the values of the two DEM 
using PixelInfo especially in the streets. What can you conclude? 

• It is clear that the two DEMs are not exactly the same. They have a 
certain degree of difference. Later on we will evaluate how much 

  

 
Now that the two DEM are made, we can use them to find out the difference 
between them. We do this by simple subtraction. 

 

��    

• Type the following formula on the command line of the main window:  
Difference:=Lidar_dem – Topo_dem 
• Accept the default values and click Show. In the display options 

window use a stretch from 0 to 20 meters.   
• The difference map is now displayed. Overlay the road map 

Roads_tegu and check the result with PixelInfo. What can you 
conclude?  

• You can clearly read the altitude of the buildings. However, also in 
the streets there is a difference, which should not be there, but is due 
to inaccurries in both DEMs.  

• Measure with PixelInfo the difference between the two DEMs for at 
least 25 points in the streets. Write down the difference in the table on 
the next page, or put them in an Excell sheet. Calculate the average 
difference.   
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Table for storing difference in altitudes in roads; 
Point Difference Point Difference Point Difference Point Difference 
1  11  21  31  
2  12  22  32  
3  13  23  33  
4  14  24  34  
5  15  25  35  
6  16  26  36  
7  17  27  37  
8  18  28  38  
9  19  29  39  
10  20  30  40  
Average difference =  
Standard deviation =  
 
 

��    

• Another way to find out the error range is to rasterize the road map 
Roads_tegu and cross this map with the map Difference. Cross 
operation can be found under Operations / Raster Operations /Cross 

•  From the cross table display the columns Difference (X-axis) and 
Npix (Y-axis). The graph you will get looks like the one below. 

  

 
 
 
 
 
 
 
 
 

��    
• Now that you know more about the average error, we will subtract a 

value from the difference, so that we might get a good differentiation 
between built-up and vacant areas. Type the following formula on the 
command line of the main window:  

Object_altitude:=difference  –  6  
• Use value range from 0 to 50 and a precision of 1. Accept the default 

values in the display options window.   
• The difference map is now displayed. You can now see that most of 

the areas that are not built-up have an undefined value Overlay the 
orthoimage map Ortho_tegu (use 50 % transparency) and evaluate  
the result. The colour map nicely coincides with the buildings. 
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The value of 6 meters was used basically to filter out the objects such as buildings, 
bridges and trees and distinguish them from the rest of the area. The value of 6 is too 
much to accurately measure the height of the buildings. A value of 4 meters would 
have been better. 

 

��    

• Now that you know more about the average error, it may be best to 
subtract this value from the difference map, so that the values for the 
building altitude are more realistic. We will now calculate a map with 
the number of floors. We assume a floor height of 3 meters. Type the 
following formula on the command line of the main window:  

Number_of _floors:=(difference  –  4 ) / 3 
• Use a value range from 0 to 25 and a precision of 1. Check the result. 

It shows that most of the city is two stories or lower. The buildings in 
the center are higher. 

 

 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Now that the number of floors are known, we will calculate the percentage of 
buildings with 1-floor, 2-floors, 3-floors, and more than 3 floors for each building 
block. 

 

��    
• Rasterize the polygon map Building_blocks_tegu using the 

georeference Tegucigalpa.   

• Cross the raster map Building_blocks_tegu with the raster map 
Number_of floors. Create a cross table Building_blocks_nof. Don’t 
ignore the undefineds in the Number_of_floors map 

• In the cross table Building_blocks_nof, first calculate the total area of 
each building block. Select Columns / Aggregate. Select the column 
Area, group by Building_blocks_tegu, output column: area_block 

• Now you can make a separate column indicating the percentage of 
each building block with buildings with a specific number of floors. 



Case study Tegucigalpa: GIS for loss estimation 

3 - 14 

Type on the command line in the table window: 
 
Perc1floor:=iff(number_of_floors=1,100*(area/area_block),0) 
Perc2floors:=iff(number_of_floors=2,100*(area/area_block),0) 
Perc3floors:=iff(number_of_floors=3,100*(area/area_block),0) 
Percover3floors:=iff(number_of_floors>3,100*(area/area_block),0) 
 
For the columns use value range of 0 to 100 and precision of 1 
 

• The last step is to get this information in the attribute table 
Building_block_tegu, though table joining. Open the table 
Building_block_tegu. Select Columns / Join.  Select table 
Building_blocks_nof and the column Perc1floor. In the Join Wizard 
accept most of the default values. Only the aggregate function should 
be Maximum. 

• Repeat this for the other columns Perc2floor, and Perc3floor. For the 
column percover3floors, you have to use the SUM aggregation 
function, instead of the maximum. 

 

 
Now you have made an estimation of the percentage of each building block covered 
by buildings with different number of stories. You can compare the results with the 
field descriptions you have made earlier. How well is the fit? 


